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Excel Skills

Importing .csv file into Excel
Freezing the Top Row

Sorting: By Error or by Person
Filtering: Narrowing down your data

Wrapping Text: Viewing all information within
a cell
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Skill 1: Importing a .csv file into
Excel



A

1. Importing .csv into Excel

« DO NOT open the .csv file directly—it will strip
the leading zeroes

* Instead, import the .csv file into Excel to review
data before submitting

O[St udentLayout 8001_20210625_0941
Save as type: | Microsoft ExcefComma Separated Values File | = S\

.CSV // XIsx

IGender BirthDate
2 5222002 02 05222002
2 3152003 o2 03152003
1 12222005 01 12222005
1 7152005 01 07152005
1 10012001 01 10012001
1 1282004 01 01282004



Account

Feedback

Options

CSV to XLSX Demonstration

Good afternoon

&)

v~ New
A O <
i
2 = ==
Blank workbook Nutrition tracker Recipe nutrition calculator
| £ Search
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1234_TestSchool_SSAFile_06112021
J:» Submissions » SPED Discipline » SY 20-21 » Summary Reports » School Folders » TestSchool

5147_LHS_2021_S

J:» Submissions = SPEI

DDisciplineSummary_06112021 - No Incidents
cipline » SY 20-21 » Summary Reports » School Folders » Launch

EQY0079_ACADC Participation_6022021Edits06112021
J: » Submissions » SPED EQY » SY 2020-21 = Files to Run » ASCENT DC

EQY0079_ACADC Participation_6022021Edits
J:» Submissions » SPED EOY = SY 2020-21 = Files ta Run » ASCENT DC

EDID-Request-Template_rev04082021 (1)

Downloads

CLA_CSI_EDIS_request_EDID_06_11_2021_J_P-RESULTS
J: » Submissions » EDID Requests » 2021-2022 » CLAVP

Edid Results (98)

Downloads

CLA_CSI_EDIS _request_EDID_06_11_2021_J_P
J:» Submissions » EDID Requests » 2021-2022 » CLAVP

CSI_DisciplineActionCombined_06112021
J: » Submissions » SPED Discipline » SY 20-21 » Files to Run » 1. Combined File

3393_GVCA_SPED_Disc_06102021
J: » Submissions » SPED Discipline » SY 20-21 » Files to Run » Golden View

Book36 - Excel

Periodic table

US college decision helper US relocation helper

[

Planets and comets

Date modified

11m ago

56m age

1hago

1hago

Thago

3hago

3hago

3hago

3hago

3hago

Hartung, Ryan @ @ -2

Stars and constellations

Baby name finder

More templates —>




IMPORTED
CORRECTLY
GENDER BIRTH DATE
02 04131999
02 03242002
02 07232007

P

Has leading zeroes! ©

IMPORTED
INCORRECTLY

"GENDER BIRTH L
2 4131999
2 3242002
2 7232007

I

Doesn’t have leading zeroes! ®



Skill 2: Freezing the Top Row



A

Freezing the Top Row

This skill will help you to scroll through and
review multiple rows of data while still being able

to see the top row that has each of the field
names.



Instructions

1. Go tothe View tab
2. Select the Freeze Panes command
3. Choose "Freeze Top Row”

1 Help  ACROBAT

v Formula Bar Q 0 _d ﬁNewWindow ESplit s | (|_)=||j [

. | Wi &
1 Gridlines [7] Headi Zoom 100% Zoom to | IS ATNGE At /] Hidle Switch | M
nafines s Selection 2 ﬁ:ﬂFreeze Pa [ MO Windows ¥

Show Zoom g Unfreeze Panes v

Unlock all rows and columns to scroll
through the entire worksheet.

.
i

Freeze Top Row

Keep the top row visible while scrolling
through the rest of the worksheet.

e Freeze First Column
i

H | | J | K | L . H Keep the first column visible while scrolling
through the rest of the worksheet.

NN
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tion

a

2 Comments

File Insert Page Layout Formulas Data Review View Help ACROBAT
Eﬁ [(BFomTet/csv  [® Refent Sources [E’ @ Queries & Connections [(é & 8 4 Flash Fill Sz Consolidate
[® From Web [P Existing Connections +F Uh [ @ © U:U ~ o | B s B} Remove Duplicates &3
res| " = z Ol liter ext to
Data - 8 From Table/Range Allv Ahocks Currencies: _Geography °| | & S@Advanced | Columns E® Data Validation v [l Manage Data Model
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools
A2 S 8001
A G D _E F G 1 b ~ M [ Q R S a0 u v w X
1 District Error Code Error Message ~ SASID First Narr Last Nam Gendei Birth Date School Ent Entry Grad School Ent School Exit School Exit Retention (Pupils Atte County of f District of f Country Pa State of PzPublic ScheDate First | Primary Sc Innovative
2 (8001 1 SP382 There is not a m: 9897196145 Katalina Abraham 1 1E+07 8242020 70 0 0 0 4 0 20 0 0 80 8012013 1 0
3 8001 E SP382 There is not a mi 9841625170 Tyler Abraham 2 7192004 8242020 100 3 0 0 0 4 0 480 0 0 80 8012009 1 0
4 /8001 E SP382 There is not a mi 4762651251 Amaia  Abraham 1 9302005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0
5 8001 E SP382 There is not a mi 4192056547 Vanna  Abraham 1 1102005 8242020 100 2 0 0 0 4 0 470 0 0 80 0 1 0
6 '8001 E SP430 District Code of P 2463381992 Nevaeh Abraham 1 5092008 8312020 70 3 0 0 0 4 0 70 0 0 80 8012013 1 0
7’8001 E  SP382 There is not a m: 1854813846 Evelyn  Abraham 1 4192010 8242020 50 2 0 0 0 4 0 20 0 0 80 0 1 0
8 /8001 E SP382 There isnota m: 754575574 Ashley Abraham 1 1.2E+07 8242020 120 2 0 0 0 4 0 70 0 0 80 8012008 1 0
9 /8001 E  SP382 Thereisnotam: 517473513 Eun Sung Abraham 2 1E+07 8242020 110 2 0 0 0 4 0 20 0 0 80 0 1 0
10 /8001 E SP382 There is not a m: 9633370025 Penny  Allan 1 8292011 8242020 40 2 0 0 0 4 0 20 0 ] 80 8012016 1 0
1178001 E SP382 There is not a mi 7046344824 Ryan Allan 2 1.2E+07 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0
128001 E SP382 There is not @ m: 3882155536 Skylar  Allan 1 6192015 8242020 7 13 0 0 0 4 0 20 0 0 80 8202020 1 0
138001 E SP382 There is not a m 3583211311 Madison Allan 1 2042005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0
1418001 E SP382 There is not a m: 3495656005 Abby Allan 1 5282009 8232020 60 2 8232020 13 0 4 0 40 0 0 80 0 1 0
158001 E SP382 There is not a m: 3276609995 Bridget  Allan 1 8062002 8242020 120 2 0 0 4 0 20 0 0 80 8182011 1 0
168001 E  SP425 Exit date can only 2566967971 Lucy Allan 1 1E+07 8232020 30 2 8232020 13 0 4 0 20 0 0 80 8172017 1 0
178001 E SP382 There is not a m: 2214695989 Addisyn Allan 1 9092009 8242020 60 2 0 0 0 4 0 20 0 ] 80 8012014 A 0
188001 E SP382 There is not a mi 1032736209 Kamryn Allan 1 1.1E+07 8242020 90 2 0 0 0 4 0 20 0 ] 80 0 1 0
198001 E SP382 There is not a m: 9863291641 Reese  Alsop 1 5072010 8232020 50 2 8232020 13 0 4 0 70 0 0 80 0 d 0
20 /8001 E SP382 There is not a m: 9826082662 Shandon Alsop 2 9142014 8242020 10 2 0 0 0 4 0 20 0 0 80 8152019 1 0
218001 E SP382 There is not a m: 7439142009 Miranda Alsop 1 9262002 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0
22"8001 E SP382 There is not a m: 6826310642 Enicia  Alsop 1 9282002 8242020 120 2 0 0 0 4 0 3090 0 0 80 8182010 1 0
2378001 E SP382 There is not a mi 7739794292 Taras  Andersor 2 1.2E+07 8242020 90 13 0 0 0 4 0 20 0 0 80 8012019 1 0
2418001 E SP382 There is not a mi 7083033410 Jalyn Andersor 1 1.2E+07 8242020 30 2 0 0 0 4 ] 480 0 0 80 8172017 1 0
258001 E SP425 Exit date can only 6493923406 Ashley  Andersor 1 3172015 8242020 7 6 0 0 0 4 0 20 0 0 80 8242020 1 0
268001 E  SP382 There is not a m: 5464717987 Landon Andersor 2 4262009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0
277'8001 E SP382 There is not @ m: 3587284486 Peyton  Andersor 1 5182015 8242020 7 1 0 0 0 4 0 40 0 0 80 8202020 1 0
28 /8001 E SP382 There is not a m: 2716742492 Katie Andersor 1 5212003 8242020 120 2 0 0 0 4 o 20 0 0 80 0 1 0
298001 E SP425 Exit date can only 1069905044 Oluwatot Andersor 2 1E+07 8242020 120 2 0 0 0 4 0 20 0 ] 80 8012008 1 0
308001 E SP382 There is not a mi 845645210 Annabellc Andersor 1 1.2E+07 8242020 50 2 0 0 0 4 0 20 0 0 80 8012015 1 0
31/8001 E  SP425 Exit date can only 9561764991 Kay Arnold 1 1.2E+07 8242020 90 2 0 0 0 4 0 470 0 0 80 0 1 0
328001 E SP448 CDE cannot calcu 8733246232 Matteo  Arnold 2 3132015 8242020 7 1 0 0 0 4 0 20 0 0 80 8202020 1 0
33?8001 E SP382 There is not a m: 8705493622 Paul Arnold 2 1.1E+07 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0
34 8001 E  SP425 Exit date can only 7881703400 Kaleigha Arnold 1 9152005 8242020 100 2 0 0 0 4 0 20 0 0 80 0 L 0
35 8001 E SP382 There is not a mi 7322154069 Kayden Arnold 1 9222006 8242020 90 2 0 0 0 4 ] 20 0 0 80 0 1 0
36 8001 E SP382 There is not a mi 7036053470 Michael Arnold 2 9262006 8242020 90 2 0 0 0 4 0 20 0 0 80 0 1 0
3718001 E SP382 There is not a mi 6955914310 Mason  Arnold 2 3312005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0
38 '8001 E SP425 Exit date can only 3836787293 Janel Arnold 1 3272010 8242020 50 2 0 0 0 4 0 20 0 0 80 0 1 0
39 8001 E  SP382 There is not a m: 3669142509 Haley  Arnold 1 1E+07 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0
40 ' 8001 E SP382 There is not a m: 1761698379 Alaina  Arnold 1 7202004 8242020 110 2 0 0 0 A 0 20 0 0 80 0 1 0
41 8001 E SP382 There is not a m: 1623648100 Owen  Arnold 2 7122013 8242020 10 2 0 0 0 4 0 20 0 0 80 8162018 1 0
428001 E SP382 There is not a mi 1048471851 Kellen  Arnold 2 4232014 8242020 10 2 0 0 0 4 0 20 0 0 80 8152019 1 0
438001 E SP382 There is not a m: 9102951482 Colette  Avery 1 1222008 8242020 70 11 0 0 0 4 0 20 0 ] 80 8012013 1 0
448001 E SP382 There is not a m: 6029176576 Haylee Avery 1 3092006 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0
45 '8001 3 SP382 There is not @ mi 5629451484 Adam  Avery 2 7152015 8242020 7 1 0 0 0 4 0 20 0 0 80 8202020 1 0
46 /8001 E SP382 There is not a m: 4862064897 Johanni Avery 1 4032006 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0
4778001 E SP382 There is not a m: 4789872222 Josiah  Avery 2 4142009 8242020 60 2 9082020 13 0 4 0 70 0 0 80 8012015 1 0
48 8001 E SP425 Exit date can only 4436982498 Mercury Avery 1 1242009 8242020 50 2 0 0 0 4 0 1420 0 0 80 0 1 0
49 8001 E  SP430 District Code of P 2711513370 Ryan Avery 2 3302009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0
50 8001 E SP382 There is not a m: 1031535062 Rylie Avery 1 3102004 8242020 110 2 0 0 0 4 0 20 0 0 80 0 1] 0
51 soul E  SP382 Thereisnotam: 669811464 James Avery 2 5252005 8242020 100 2 0 0 0 4 0 20 0 0 80 0 1 0
52 8001 E SP382 There is not a me¢ 178993116 Zachary Avery 2 4132013 8242020 20 15 0 0 0 4 0 20 0 0 80 8012018 1 0
page ® <

cocoocococoococooccocoocooccooco0coo0c0cc0oc00c000c0000Cc0000 00
R e R T R e e e e R T T T e T I T I T I I T I I I T T )
e N e R R I I R e e R A R R A N R R - R N R I R R I I I I )
I I R e R R I R R T e I I N A I R I I I I A I I I )
cocooccococoococo0occoooco0c0o000000000000000000000000O0 000000

Expelled EcHome Base Gifted Gen: Gifted Crez Gifted Leac Glfted RealGifi| |

0

R I I R I R R R R R R I R R I R R I N R I I R R R R R R R I R R I I R I I R I - )




Skill 3: Sorting



A

Sorting

This skill will help you to organize large amounts
of data based on a particular column.

Examples:

 Sorting an error report by SASID/EDID to
identify all errors associated with a
student/staff

e Sorting an error report by Error type to identify
all students/staff with the same error.



Instructions

1. Select a cell in the column you want to sort.

2. On the Data tab, in the Sort & Filter group,
select how you want to sort (Ato Z; Zto A)

@ Review View Help ACROBAT

Eﬂueries & Connections @ @ i
- [R

Vo

Filter
Eﬂdvanced

Rort & Filter

AV g

v
a

Stocks Currencies |=

Queries & Connections Data Types



Demonstration

File Home Insert Page Layout Formulas Data Review View Help ACROBAT 1 Share 2 Comments
From Text/CSV Recent Sources Queries & Connections 7 =B &riashrin & Consolidate I [ 5
B Bre Lo @ @ W 4 M o o B BB <H ¢ &H
- [ From Web [ Existing Connections et ~ | : B} Remove Duplicates &3 T 5 ¥ R
Dot B From Table/Range A Stocks  Currencies Geography Automatic  Amatomy |3 | X fher SRAdvanced | Columns 55 Data Validation ~ [ Manage Data Model Ana,;;s O SRR
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools Forecast Outline ] ~
122 x b2 9282002 v
A B fef D E F G H 1 ] K L M N (i Q R S E U v w X Y z AA AB AC AL ~
1 |District Error Code Error Message  SASID First Nam Last Nam Gendei Birth Date School Entry Date Entry Grad School Ent School Exit School Exit Retention (Pupils Atte County of  District of f Country Pa State of Pz Public SchcDate First | Primary Sc Innovative Expelled EcHome Base Gifted Gen: Gifted Crez Gifted Leac Gifted |
2 7'8001 E SP382 There is not a m: 9897196145 Katalina Abraham 1 1E+07 8242020 70 13 0 0 0 4 0 20 ] ] 80 8012013 1 0 0 0 0 0 0
3 Boo1 E SP382 There is not a mi 9841625170 Tyler Abraham 2 7192004 8242020 100 13 0 0 0 4 0 480 0 0 80 8012009 1 0 0 0 0 0 0
4 8001 E SP382 There is not a mi 4762651251 Amaia  Abraham 1 9302005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0
5 /8001 E  SP382 There is not a m 4192056547 Vanna  Abraham 1 1102005 8242020 100 2 0 0 0 4 0 470 0 0 80 0 1 0 0 0 0 0 0
6 8001 E  SP430 District Code of P 2463381992 Nevaeh Abraham 1 5092008 8312020 70 13 0 0 0 4 0 70 0 0 80 8012013 1 0 0 0 0 0 0
7 o001 E SP382 There is not a mi 1854813846 Evelyn  Abraham 1 4192010 8242020 50 2 0 0 0 4 0 20 0 0 80 0 1 ] 0 0 0 0 0
8 8001 E SP382 There is nota m: 754575574 Ashley Abraham 1 1.2e+07 8242020 120 2 0 0 0 4 0 70 0 0 80 8012008 1 0 0 0 0 0 0
9 '8001 E  SP382 Thereisnotam: 517473513 Eun Sunc Abraham 2 1E+07 8242020 110 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
10 /8001 E SP382 There is not a mi 9633370025 Penny  Allan 1 8292011 8242020 40 2 0 0 0 4 0 20 0 0 80 8012016 1 0 0 0 0 0 0
1178001 E SP382 There is not a m: 7046344824 Ryan Allan 2 1.2e+07 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0
128001 E SP382 There is not a mi 3882155536 Skylar  Allan 1 6192015 8242020 7 13 0 0 0 4 0 20 0 0 80 8202020 1 0 0 0 0 0 0
1378001 E SP382 There is not a mi 3583211311 Madison Allan 1 2042005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0
14 /8001 E SP382 There is not a mi 3495656005 Abby Allan 1 5282009 5] 8232020 60 2 8232020 13 0 4 0 40 0 0 80 0 1 0 0 0 0 0 0
158001 E SP382 There is not a mi 3276609995 Bridget  Allan 1 8062002 8242020 120 2 0 0 0 4 0 20 0 0 80 8182011 1 0 0 0 0 0 0
16 /8001 E SP425 Exit date can only 2566967971 Lucy Allan 1 1E+07 8232020 30 2 8232020 13 0 4 0 20 0 0 80 8172017 1 0 0 0 0 0 0
178001 E SP382 There is not a mi 2214695989 Addisyn Allan 1 9092009 8242020 60 2 0 0 0 4 0 20 0 0 80 8012014 1 0 0 0 0 0 0
188001 E SP382 There is not a mi 1032736209 Kamryn Allan 1 1.1E+07 8242020 90 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
198001 E SP382 There is not a mi 9863291641 Reese  Alsop 1 5072010 8232020 50 2 8232020 13 0 4 0 70 0 0 80 0 1 0 0 0 0 0 0
2018001 E  SP382 There is not a m: 9826082662 Shandon Alsop 2 9142014 8242020 10 2 0 0 0 4 0 20 0 0 80 8152019 1 0 0 0 0 0 0
218001 E SP382 There is not a m¢ 7439142009 Miranda Alsop 19262002 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
22(8001 E SP382 There is not a m: 6826310642 Enicia  Alsop 1] 92820021 8242020 120 2 0 0 0 4 0 3090 0 0 80 8182010 1 0 0 0 0 0 0
238001 E  SP382 There is not a mi 7739794292 Taras  Andersor 2 1.2E+07 8242020 90 13 0 0 0 4 0 20 0 0 80 8012019 1 0 0 0 0 0 0
247'8001 E SP382 There is not a m: 7083033410 Jalyn Andersor 1 1.2E+07 8242020 30 2 0 0 0 4 0 480 0 0 80 8172017 1 0 0 0 0 0 0
2578001 E SP425 Exit date can only 6493923406 Ashley  Andersor 1 3172015 8242020 7 6 0 0 0 % 0 20 0 0 80 8242020 1 0 0 0 0 0 0
268001 E SP382 There is not a mi 5464717987 Landon Andersor 2 4262009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
27,'8001 E  SP382 There is not a m: 3587284486 Peyton  Andersor 1 5182015 8242020 7 1 0 0 0 4 0 40 0 0 80 8202020 1 0 0 0 0 0 0
288001 E SP382 There is not a mi 2716742492 Katie Andersor 1 5212003 8242020 120 2 0 0 1] 4 0 20 0 0 80 0 1 0 0 0 0 0 0
208001 E SP425 Exit date can only 1069905044 Oluwatok Andersor 2 1E+07 8242020 120 2 0 0 0 4 0 20 0 0 80 8012008 1 0 0 0 0 0 0
308001 E SP382 There is not a mi 845645210 Annabell¢ Andersor 1 1.26+07 8242020 50 2 0 0 0 4 0 20 0 0 80 8012015 1 0 0 0 0 0 0
3178001 E SP425 Exit date can only 9561764991 Kay Arnold 1 1.2E+07 8242020 90 2 0 0 0 4 0 470 0 0 80 0 1 0 0 0 0 0 0
328001 E SP448 CDE cannot calcu 8733246232 Matteo  Arnold 2 3132015 8242020 7 1 0 0 0 4 0 20 0 0 80 8202020 1 0 0 0 0 0 0
3308001 E SP382 There is not a mi 8705493622 Paul Arnold 2 1.1E407 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0 0 0 0 0 0 |
348001 E SP425 Exit date can only 7881703400 Kaleigha Arnold 1 9152005 8242020 100 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
357'8001 E SP382 There is not a mi 7322154069 Kayden Arnold 1 9222006 8242020 90 2 0 0 0 4 0 20 ] 0 80 0 1 0 0 0 0 0 0 |
36 /8001 E SP382 There is not a mi 7036053470 Michael Arnold 2 9262006 8242020 90 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
3778001 E SP382 There is not a mi 6955914310 Mason  Arnold 2 3312005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0
388001 E  SP425 Exit date can only 3836787293 Janel Arnold 1 3272010 8242020 50 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
398001 E SP382 There is not a mi 3669142509 Haley  Arnold 1 1E+07 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
40 /8001 E SP382 There is not a mi 1761698379 Alaina  Arnold 1 7202004 8242020 110 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
4118001 E  SP382 There is nota m: 1623648100 Owen  Arnold 2 7122013 8242020 10 2 0 0 0 4 0 20 0 0 80 8162018 1 0 0 0 0 0 0
4278001 E SP382 There is not a mi 1048471851 Kellen  Arnold 2 4232014 8242020 10 2 0 0 0 4 0 20 0 0 80 8152019 1 0 0 0 0 0 0
437’8001 E SP382 There is not a mi 9102951482 Colette  Avery 1 1222008 8242020 70 1 0 0 0 4 0 20 0 0 80 8012013 1 0 0 0 0 0 0
448001 E SP382 There is not a m: 6029176576 Haylee Avery 1 3092006 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0 0 0 0 0 0
458001 E SP382 There is not a mi 5629451484 Adam  Avery 2 7152015 8242020 7 1 0 0 0 4 0 20 0 0 80 8202020 1 0 0 0 0 0 0
46 8001 E SP382 There is not a m: 4862064897 Johanni Avery 1 4032006 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0 0 0 0 0 0
477'8001 E SP382 There is not a mi 4789872222 Josiah  Avery 2 4142009 8242020 60 2 9082020 13 0 4 0 70 0 0 80 8012015 1 0 0 0 0 0 0
488001 E SP425 Exit date can only 4436982498 Mercury Avery 1 1242009 8242020 50 2 0 0 0 4 0 1420 o 0 80 0 1 0 0 0 0 0 0 |
497'8001 E  SP430 District Code of P 2711513370 Ryan Avery 2 3302009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
508001 E SP382 There is not a mi 1031535062 Rylie Avery 1 3102004 8242020 110 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
517'8001 E  SP382 Thereisnotam: 669811464 James Avery 2 5252005 8242020 100 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
52 :3001 E  SP382 There isnotam: 178993116 Zachary Avery 2 4132013 8242020 20 15 0 0 0 4 0 20 0 0 80 8012018 1 0 0 0 0 0 0 -

®

page




Skill 4: Filtering



A

Filtering

This skill will help you to temporarily hide some
of the data In a table, so you can focus on the
data you want to see.

Examples:

* Filtering an error report by SASID/EDID so you
only see errors associated with a student/staff

* Filtering an error report by Error type so you
only see students/staff with the same error.



Instructions

1. Select any cell within the range.
2. Select Data > Filter.

1 - Review View Help ACROBAT

[CH Queries & Connections al IzTa

= m @ W £ O g HEE

h B Stocks Currencies  Geography  Automatic ~ Anatomy |3| | £ Sort
Queries & Connections Data Types

3. Select the column header arrow '~

SASID |~ |SCHO|~ |STUDERN ~ |STUDER ~ | GENDEI ~ |BIRTH |~ |[ENTRY | ¥ | GRADE| ~ |[ENTRY | ~ |[EXIT Dy ~ |EXIT Ty-T|F




Demonstration

File Home Insert Page Layout Formulas Data Review View Help ACROBAT 1 Share & Comments
[%s, ik Tahoma Yo A A 2 Wrap Text General < Bl BFZ [vema Bad Good R B | ZAuesm - Ay /O .
B Copy ~ = - = Fill ~ 4
Paste Conditional Format as a Insert Delete Format Sort& Find& | Analyze
U~ e SAEY = v O «0 .00 Neutral Calculation = lyz
> Sromatpainte | B2 L L~ [HE = [ Merge & Center $2% 0| WA | e~ Tible~ v v v | @©Cer~  Fpeesdet~ | D
Clipboard (] Font ] Alignment ~ Number & Styles Cells Editing Analysis Sensitivity A
E8 x S 6707177214 v
A B C D E F G H I ] K L M N o () Q R S E U \' w X Y z AA AB AC AL 4]
1 |District Error Code Error Message  SASID First Nam Last Nam Gendei Birth Date School Entry Date Entry Grad School Ent School Exit School Exit Retention ¢ Pupils Atte County of f District of f Country Pa State of Pz Public SchcDate First |Primary Sc Innovative Expelled EcHome Base Gifted Gen: Gifted Crez Gifted Leac Gifted |
g £yl L 2 A p ty of £ 2 dic:t ny. P |
2’8001 E 99999 The SASID isinvi 493546653 Santiago Ellison 2 1242015 8242020 7 13 0 0 0 4 0 20 ] 0 80 8202020 1 0 0 0 0 0 0
3 8001 E 99999 The SASID is invi 7577101623 Peyton Langdon 1 9062012 9142020 30 13 9172020 15 0 4 0 70 0 0 80 8012017 1 0 0 0 0 0 0
4 8001 E 99999 The SASID is invi 8061537956 Mackenzi Powell 1 9122007 8242020 80 13 0 0 0 4 0 40 0 0 80 8012012 1 0 o 0 0 0 0
s fsoo1 E SP125 Public School Fini 1731162258 Jagsynne McGrath 1 6272005 8242020 100 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
6’8001 E SP125 Public School Fini 8794598665 Elle Payne 1 4022007 8232020 80 2 8232020 13 0 4 0 0 0 80 8012012 1 0 0 0 0 0 0
7 flBoo1 E SP23 Grade Level does 3232318934 Logan  Brown 2 6302009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
8 EZOOI E SP24  Pupils Aﬁendanc{ 6707177214'0|ivia Graham 1 1312011 8242020 40 0 0 0 4 0 70 0 0 80 0 1 0 0 0 0 0 0
8001 E  SP24 Pupils Attendance 5798873244 Emily  Terry 1 9222007 8242020 70 2 5122021 90 2 4 0 20 0 0 80 0 1 0 0 0 0 0 0
108001 E  SP267 Exit Date must be 9321944973 Ashlyn  Blake 1 8272007 8242020 80 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
1178001 E SP267 Exit Date must be 5079939259 Anika Cornish 1 3312005 8242020 100 2 0 0 3 4 0 20 0 0 80 0 1 0 0 0 0 0 0
128001 E  SP273 Exit Type must b¢ 2968530186 Leila King 1 2062014 8242020 10 2 0 0 0 4 0 10 0 0 80 8152019 1 0 0 0 0 0 0
137'8001 E  SP275 Exit Type must b¢ 9762737384 Ethan  Berry 2 5042010 8242020 50 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
14"8001 E SP275 Exit Type must b¢ 8780954832 Jessa Carr 1 1.1E+07 242020 7 2 0 0 0 4 0 20 0 0 80 8152019 1 0 0 0 0 0 0
158001 E SP275 Exit Type must b¢ 9114726221 Malachi Johnston 2 8212015 242020 7 13 5262021 11 0 4 0 20 0 0 80 7022020 1 0 0 0 0 0 0 ‘
168001 E  SP275 Exit Type must b¢ 8358011861 Diego  Lewis 2 7152003 120 2 0 0 0 4 0 8001 0 0 80 0 1 0 0 2 0 0 0
1778001 E SP275 Exit Type must b¢ 2840688251 Allan Mackenzi 2 1.1E+07 8242020 120 2 0 13 2 4 0 40 0 0 80 0 1 0 0 0 0 0 0
188001 E  SP275 Exit Type must b¢ 7325173960 Margaret Mathis 1 1.1E+07 8232020 90 2 8232020 13 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
1978001 E SP275 Exit Type must b¢ 4717581933 Connor Ogden 2 9222015 8242020 6 0 0 0 4 0 1420 0 0 80 8202020 1 0 0 0 0 0 0
20 /8001 E SP275 Exit Type must b¢ 6091053444 Nicholas Springer 2 8052005 8242020 100 2 0 0 1 4 0 20 0 0 80 0 1 0 0 0 0 0 0
218001 E SP275 Exit Type must b¢ 808236611 Cieara  Tucker 1 1.2e+07 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
228001 E SP29  Public School Fini 3760002074 Layla Berry 1 9082014 8242020 10 2 0 0 0 4 0 20 0 0 80 8152019 1 0 0 0 0 0 0 |
2378001 E  SP29 Public School Fini 9014539729 Nina Rampling 1 1022007 8242020 80 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
247'8001 E SP303 Student retention 9290322727 Alexande Lewis 2 1E+07 9082020 30 13 5202021 11 0 4 0 20 0 0 80 8012017 1 0 0 0 0 0 0 |
2578001 E SP317 Only Districts witt 5676603278 Kimberly Robertso 1 6152005 8242020 100 2 0 0 0 & 0 70 ] 0 80 8012010 1 0 0 0 0 0 0 \
268001 E  SP373 Student may only 2419901028 Kurtis ~ Walsh 2 1.2e+07 8242020 50 2 5262021 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
2718001 E  SP382 There is not a m: 4192056547 Vanna  Abraham 1 1102005 8242020 100 2 0 0 0 4 0 470 0 0 80 0 1 0 0 0 0 0 0
28 /8001 E SP382 There is not a mi 9841625170 Tyler Abraham 2 7192004 8242020 100 13 0 0 1] 4 0 480 0 0 80 8012009 1 0 0 0 0 0 0 |
29 /8001 E SP382 There is not a mi 9897196145 Katalina Abraham 1 1E+07 8242020 70 13 0 0 0 4 0 20 0 0 80 8012013 1 0 0 0 0 0 0 |
308001 E SP382 There is not a mi 1854813846 Evelyn  Abraham 1 4192010 8242020 50 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
317'8001 E  SP382 There isnota m¢ 517473513 Eun Sunc Abraham 2 1E+07 8242020 110 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
328001 E SP382 There is nota mi 754575574 Ashley Abraham 1 1.2e+07 8242020 120 2 0 0 0 4 0 70 0 0 80 8012008 1 ] 0 0 0 0 0 |
3378001 E SP382 There is not a mi 4762651251 Amaia  Abraham 1 9302005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0 |
348001 E SP382 There is not a m: 3882155536 Skylar  Allan 1 6192015 8242020 7 13 0 0 0 4 0 20 ] 0 80 8202020 1 0 0 0 0 0 0 |
358001 E SP382 There is not a mi 7046344824 Ryan Allan 2 1.2E+07 8242020 100 2 0 0 0 4 0 20 ] 0 80 8012010 1 0 0 0 0 0 0 |
368001 E SP382 There is not a mi 9633370025 Penny  Allan 1 8292011 8242020 40 2 0 0 0 4 0 20 0 o 80 8012016 1 0 0 0 0 0 0 |
378001 E SP382 There is not a mi 3583211311 Madison Allan 1 2042005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0 |
388001 E  SP382 There is nota m: 1032736209 Kamryn Allan 1 1.1E+07 8242020 90 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
3978001 E  SP382 There is not a m: 3276609995 Bridget Allan 1 8062002 8242020 120 2 0 0 0 4 0 20 0 0 80 8182011 1 0 0 0 0 0 0
40 /8001 E SP382 There is not a mi 2214695989 Addisyn Allan 1 9092009 8242020 60 2 0 0 0 4 0 20 0 0 80 8012014 1 0 0 0 0 0 0
418001 E  SP382 There is nota m: 3495656005 Abby Allan 1 5282009 8232020 60 2 8232020 13 0 4 0 40 0 0 80 0 1 0 0 0 0 0 0
427'3001 E  SP382 There is not a m: 9826082662 Shandon Alsop 2 9142014 8242020 10 2 0 0 0 4 0 20 0 0 80 8152019 1 0 0 0 0 0 0
438001 E SP382 There is not a m: 9863291641 Reese  Alsop 1 5072010 8232020 50 2 8232020 13 0 4 0 70 0 0 80 0 1 0 0 0 0 0 0
4418001 E  SP382 There is nota m: 7439142009 Miranda Alsop 1 9262002 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
458001 E  SP382 There is not a m: 6826310642 Enicia Alsop 1 9282002 8242020 120 2 0 0 0 4 0 3090 0 0 80 8182010 1 0 0 0 0 0 0 |
46 8001 E SP382 There is not a mi 7739794292 Taras  Andersor 2 1.2E+07 8242020 90 13 0 0 0 4 0 20 0 0 80 8012019 1 0 0 ] 0 0 0
477'8001 E  SP382 There is not a mi 3587284486 Peyton  Andersor 1 5182015 8242020 7 1 0 0 0 4 0 40 0 0 80 8202020 1 0 0 0 0 0 0
488001 E SP382 There is not a mi 5464717987 Landon  Andersor 2 4262009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
497'8001 E SP382 There is not a mi 2716742492 Katie Andersor 1 5212003 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
50 %001 E SP382 There is not a mi 7083033410 Jalyn Andersor 1 1.2e+07 8242020 30 2 0 0 0 4 0 480 0 0 80 8172017 1 0 0 0 0 0 0 |
518001 E SP382 There is nota m: 845645210 Annabell¢ Andersor 1 1.2e+07 8242020 50 2 0 0 0 4 0 20 0 0 80 8012015 1 0 0 0 0 0 0 \
52 :8001 E SP382 There is not a m: 8705493622 Paul Arnold 2 1.1E+07 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0 0 0 0 0 0 |+
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Skill 5: Wrapping Text



Wrapping Text

This skill will help allow you to read Error and
Warning messages in full within a cell view.

A



Instructions

1. Select a cell or a column of cells you wish to
review.
2. On the Home tab click Wrap Text
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Demonstration

File Home Insert Page Layout Formulas Data Review View Help ACROBAT 8 Share &2 Comments
I_E& oL Tahoma 1o v A A L 25 Wrap Text General v @ @ Normal Bad Good @ g):( @ AutoSum - %? /O
B Copy ~ i - Fill 4
Paste et = > - 0 .00 Conditional Format as C o Insert Delete Format Sort& Find& | Analyze
v Sromatpainter | B T U~ [H Qv &~ = B Merge & Center $-% 9 WA Formatting~ Table v My s v v v & Clear~ Filter v Select v Date
Clipboard & Font & Alignment [} Number [} Styles Cells Editing Analysis | Sensitivity ~
P13 v £ || a v
A |B| € D E F G H 1 3 K L M N o P Q R s v w X Y z A | AB AC 4[]
1 Distr v Er v Cod v Error Message |v SASID |~ First \~ Last N v Gen - Birth Di v | School Entry Da » | Entry Gt ¥ | School | ¥ | School | ~ | School | v | Retentic v | Pupils A ~ | County | ~ District | * | Country v 'State of v | Public S v Date Fir ~ | Primary v | Innovati ~ | Expellec * |Home B ¥ Gifted G v | Gifted C v | Gifted L v | Gifte
2 7'8001 E 89999 The SASID is invali 493546653 Santiago Ellison 2 1242015 8242020 7 13 0 0 0 4 0 20 0 0 80 8202020 1 0 0 0 0 0 0
3 /8001 E 99999 The SASID is invali 7577101623 Peyton  Langdon 1 9062012 9142020 30 13 9172020 15 0 4 0 70 0 0 80 8012017 1 0 0 0 0 0 0
4 '8001 E 99999 The SASID is invali 8061537956 Mackenzi Powell 1 9122007 8242020 80 13 0 0 0 4 0 40 0 0 80 8012012 1 0 0 0 0 0 0
5 /8001 E  SP125 Public School Finar 1731162258 Jagsynne McGrath 1 6272005 8242020 100 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
6 /8001 E SP125 Public School Finar 8794598665 Elle Payne 1 4022007 8232020 80 2 8232020 13 0 4 0 0 0 80 8012012 1 0 0 0 0 0 0
7 8001 E  SP23 Grade Level does n 3232318934 Logan  Brown 2 6302009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 1] 0
8 8001 E  SP24 Pupils Attendance 16707177214 Olivia  Graham 1 1312011 8242020 40 0 0 0 4 0 70 0 0 80 0 1 0 0 0 0 0 0
9 /8001 E  SP24 Pupils Attendance 1 5798873244 Emily  Terry 1 9222007 8242020 70 2 5122021 90 2 4 0 20 0 0 80 0 1 0 0 0 0 Q 0
10»’8001 E SP267 Exit Date must be z 9321944973 Ashlyn  Blake 1 8272007 8242020 80 2 0 0 ] 4 0 20 0 0 80 0 1 0 0 0 0 0 0
1178001 E SP267 Exit Date must be z 5079939259 Anika Cornish 1 3312005 8242020 100 2 0 0 3 4 0 20 0 0 80 0 1 o 0 0 0 0 0
1278001 E  SP273 Exit Type must be 1 2968530186 Leila King 1 2062014 8242020 10 2 0 0 0 4 0 10 0 0 80 8152019 | 0 0 0 0 0 0
13 £8001 E  SP275 Exit Type must be « 9762737384 Ethan  Berry 2 5042010 8242020 50 2 0 0 0] 4_] 0 20 0 0 80 0 1 0 0 0 0 0 0
14 8001 E SP275 Exit Type must be « 8780954832 Jessa Carr 1 1.1E+07 8242020 7 2 0 0 0 4 0 20 0 0 80 8152019 1 0 0 0 0 0 0
158001 E SP275 Exit Type must be « 9114726221 Malachi Johnston 2 8212015 8242020 7 13 5262021 11 0 4 0 20 0 0 80 7022020 1 0 0 0 0 0 0
168001 E  SP275 Exit Type must be « 8358011861 Diego  Lewis 2 7152003 120 2 0 0 0 4 0 8001 0 0 80 0 1 0 0 1 0 0 0 |
178001 E  SP275 Exit Type must be < 2840688251 Allan Mackenzi 2 1.1E+07 8242020 120 2 0 13 2 4 0 40 0 0 80 0 1 0 0 0 0 1) 0
13778001 E SP275 Exit Type must be « 7325173960 Margaret Mathis 1 1.1E+07 8232020 90 2 8232020 13 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
198001 E SP275 Exit Type must be « 4717581933 Connor  Ogden 2 9222015 8242020 6 0 0 0 4 0 1420 0 0 80 8202020 1 0 0 0 0 0 0
208001 E  SP275 Exit Type must be « 6091053444 Nicholas Springer 2 8052005 8242020 100 2 0 0 1 4 0 20 0 0 80 0 1 0 0 0 ) 0 0
2178001 E  SP275 Exit Type must be < 808236611 Cieara  Tucker 1 1.2e+07 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 1] 1]
22778001 E  SP29 Public School Finar 3760002074 Layla Berry 1 9082014 8242020 10 2 0 0 0 4 0 20 0 0 80 8152019 1 0 0 0 0 0 0
2378001 E SP29  Public School Finar 9014539729 Nina Rampling 1 1022007 8242020 80 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
248001 E SP303 Student retention ¢ 9290322727 Alexande Lewis 2 1E+07 9082020 30 13 5202021 11 0 4 0 20 0 0 80 8012017 1 0 0 0 0 0 0
258001 E SP317 Only Districts with | 5676603278 Kimberly Robertso 1 6152005 8242020 100 2 0 0 0 4 0 70 0 0 80 8012010 1 0 0 0 0 0 0 \
268001 E  SP373 Student may only ¢ 2419901028 Kurtis ~ Walsh 2 1.2e+07 8242020 50 2 5262021 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
277'8001 E  SP382 There is not a mati 4192056547 Vanna  Abraham 1 1102005 8242020 100 2 0 0 0 4 0 470 0 0 80 0 1 0 0 0 0 0 0 |
28 8001 E SP382 There is not a mat 9841625170 Tyler Abraham 2 7192004 8242020 100 13 0 0 0 4 0 480 0 0 80 8012009 1 0 0 0 0 0 0
208001 E SP382 There is not a mat 9897196145 Katalina Abraham ¥ 1E+07 8242020 70 13 0 0 0 4 0 20 0 0 80 8012013 1 0 0 ) 0 0 0
308001 E  SP382 There is not a mat 1854813846 Evelyn  Abraham 1 4192010 8242020 50 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
317'8001 E  SP382 There is not a mate 517473513 Eun Sunc Abraham 2 1E+07 8242020 110 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 1] 0
328001 E SP382 There is not a mati 754575574 Ashley Abraham 1 1.2e+07 8242020 120 2 0 0 0 4 0 70 0 0 80 8012008 3 0 0 0 o 0 0
3378001 E SP382 There is not a mat 4762651251 Amaia  Abraham 1 9302005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 : | 0 0 0 0 0 0
348001 E  SP382 There is not a mat 3882155536 Skylar  Allan 1 6192015 8242020 7 13 0 0 0 4 0 20 0 0 80 8202020 1 0 0 0 0 0 0
357'8001 E  SP382 There is not a mati 7046344824 Ryan Allan 2 1.2E+07 020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0
368001 E  SP382 There is not a mat 9633370025 Penny  Allan 1 8292011 8242020 40 2 0 0 0 4 0 20 0 0 80 8012016 | 0 0 0 0 0 0
378001 E SP382 There is not a mat 3583211311 Madison Allan 1 2042005 8242020 100 2 0 0 0 4 0 20 0 0 80 8012010 1 0 0 0 0 0 0
388001 E  SP382 There is not a mati 1032736209 Kamryn Allan 1 1.1E+07 8242020 90 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
308001 E SP382 There is not a mat 3276609995 Bridget  Allan 1 8062002 8242020 120 2 0 0 0 4 0 20 0 0 80 8182011 1 0 0 0 0 0 0
4078001 E  SP382 There is not a mati 2214695989 Addisyn Allan 1 9092009 8242020 60 2 0 0 0 4 0 20 0 0 80 8012014 1 0 0 0 ) 0 0
418001 E SP382 There is not a mat 3495656005 Abby Allan 1 5282009 8232020 60 2 8232020 13 0 4 0 40 0 0 80 0 1 0 0 0 0 0 0
428001 E SP382 There is not a mat 9826082662 Shandon Alsop 2 9142014 8242020 10 2 0 0 0 4 ] 20 0 0 80 8152019 15 0 0 0 0 0 0
4378001 E SP382 There is not a mat 9863291641 Reese  Alsop 1 5072010 8232020 50 2 8232020 13 0 4 0 70 0 0 80 0 1 0 0 0 o 0 0
4418001 E  SP382 There is not a mati 7439142009 Miranda Alsop 1 9262002 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0
458001 E SP382 There is not a mati 6826310642 Enicia  Alsop 1 9282002 8242020 120 2 0 0 0 4 0 3090 0 0 80 8182010 1 0 0 0 0 0 0
46 8001 E SP382 There is not a mat 7739794292 Taras  Andersor 2 1.2E+07 8242020 90 13 0 0 0 4 0 20 0 0 80 8012019 1 0 0 0 0 0 0
4708001 E SP382 There is not a mat 3587284486 Peyton  Andersor 1 5182015 8242020 7 1 0 0 0 4 0 40 0 0 80 8202020 1 0 0 0 0 0 0
4818001 E  SP382 There is not a mati 5464717987 Landon Andersor 2 4262009 8242020 60 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
498001 E  SP382 There is not a mati 2716742492 Katie Andersor 1 5212003 8242020 120 2 0 0 0 4 0 20 0 0 80 0 1 0 0 0 0 0 0 |
508001 E SP382 There is not a mat 7083033410 Jalyn Andersor 1 1.2e+07 8242020 30 2 0 0 0 4 0 480 0 0 80 8172017 1 1] 0 0 0 0 0
51}001 E SP382 There is not a matt 845645210 Annabell¢ Andersor 1 1.2E+07 8242020 50 2 0 0 0 4 0 20 0 0 80 8012015 ) 0 0 0 0 0 0
52 :8001 E  SP382 There is not a mati 8705493622 Paul Arnold 2 1.1E+07 8242020 90 15 0 0 0 4 0 20 0 0 80 8012011 1 0 0 0 0 0 0 -
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CHARTER SCHOOL INSTITUTE

Thank you!

For questions contact the CSI Submissions Inbox at:
submissions csi@csi.state.co.us
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